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SOFTWARE LICENSE AGREEMENT 
IMPORTANT - READ CAREFULLY 
This is a legal agreement between you (either an individual or a single entity) and Timestone Software. By keeping this 
package and using the software, you are accepting the terms and are bound by the terms of this license. If you do not wish to 
enter into this agreement, please promptly return all copies of the Software, User Guides and Hardlock devices to Timestone 
Software for a full refund. This User Guide and the software programs it describes are protected by copyright, trade secret 
and trademark law. By accepting this license, you have the right to use them, subject to the terms and conditions of this 
license agreement. 

Definitions and Interpretation 

Software means the Program modules enabled and authorised for use for your installation. 

• Hardlock device means the hardware device used to enable the Software to function. 

• Scope of Agreement 

• Timestone Software hereby grants you, the original purchaser, personal, non-exclusive license to use the User 
Guide and the Software subject to the terms and conditions of this Agreement. 

• Grant of License. You may use the Software on a maximum of one computer that you own or operate at a 
single physical location . You may transfer the Software from one computer to another provided that you do 
not use or permit the usage of the Software on more than one computer or computer terminal at a time. 

• Copies. You may not copy or duplicate the Software, except as necessary solely for archival purposes, 
program error verification, or to replace defective storage media, provided you keep the original and the 
copies. You may not alter, decompile or disassemble the Software. 

• Transfers. You may not sublicense, lease or rent or lend the Software or transfer any of your rights under this 
Agreement. You may transfer the Software (together with any backup copies you have made), Hardlock 
device and the User Guide on a permanent basis so long as you retain no copies, the transferee agrees to be 
bound by the terms of this Agreement, and Timestone Software has authorised the transfer by written 
confirmation. 

• Term. The License granted in this agreement is effective until terminated. You may terminate it at any time by 
destroying or returning to Timestone Software the Software and the User Manual, together with all copies, 
and returning to Timestone Software the Hardlock Device. If you fail to comply with any term or condition of 
this Agreement, this License will terminate and, upon such termination, you agree to destroy or return to 
Timestone Software the Software and the User Manual, together with all copies, and return to Timestone 
Software the Hardlock Device. Termination of this license shall be in addition and not in lieu of any other 
remedies available to Timestone Software. 

Limited Warranty, Disclaimer 
Timestone Software warrants that the media on which the Software is recorded and the User Guide provided with it are free 
from defects in material and workmanship under normal use for a period of 90 days from the date of your original purchase. 
Except for the limited warranty described above, the Software is sold “as is”, and you are assuming the entire risk as to its 
quality and performance. It is your responsibility to verify the results obtained from the use of the Software. 

Limitation of Remedies 
If during the 90-day limited warranty period, you discover physical defects in the User Guide or in the Media on which the 
Software was recorded, Timestone Software will replace them as no charge to you. This is your sole remedy. 

IN NO EVENT WILL TIMESTONE SOFTWARE BE LIABLE TO ANY PERSON FOR ANY DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR SIMILAR DAMAGES, EVEN IF TIMESTONE 
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
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The MultiPrinter Windows NT Printer driver is a standard Windows NT or Windows 2000 
printer driver that lets your operators print quickly and easily to your Kodak MultiPrinter. 
The driver also features a number of imaging related  functions that will enhance your task 
of imaging files to the printer. 

Features 
The MultiPrinter printer driver offers a number of standard and enhanced functions that 
are specifically designed to improve the workflow within your lab. Although the 
MultiPrinter driver can be used as a standard driver, the MultiPrinter itself (because of its 
high-speed) demands a special approach when printing jobs to it. 

Standard functions 
Installs as a normal Windows printer 

The printer appears in the Windows Printers folder ! 

! 

! 

! 

! 

! 

! 

! 

! 

Set printer and document defaults as with a normal driver 
Choose and configure the printer from any standard Windows NT 
application 

Use the Windows printer queue 
Use the Windows print spooler to control jobs submitted to the printer 
Receive notification of the status of a job 

Share the printer 
Share the printer over a Windows NT network 
Apply user permissions for the printer 

Enhanced functions 
Image enhancement  

Applies sharpening corrections based on an unsharp-mask algorithm 
Applies color and contrast corrections created in a LUT editor 
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Network traffic 
Choose to send rendered pages to the Print Server as JPEG or PNG 
compressed image data to save network traffic 

! 

! 

! 

Integration to Timestone Software’s Distributed Print Architecture 
Specially designed to deliver pre-rendered pages at very high speed to the 
printer 
Specific support for Timestone Print Job files created by the Distributed 
Print Architecture for a streamlined and efficient production workflow 

Many of these features are discussed in either the Windows NT documentation, or in the 
appropriate ‘Neo’ documentation. While enough information is provided in this manual 
for you to install, configure and use the printer driver, you may want to further consult the 
other documentation for specific information. 
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Open the CD-Rom in Windows Explorer or My Computer, and double-click the file, 
Setup. The installer welcome screen is displayed.  

 
Click Install Driver to start the installation process. 

 

Select your printer model from the list, then choose Install. The Setup program now copies 
all the relevant files to your system. 
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After installation, you can define and add a printer to your Printers Folder. Choose Yes to 
add a new printer. 

 
All printer drivers in Windows NT/2000 use a port to communicate to the actual printer. 
Choose Add Port… to add a new port for your printer. 

 
There are several settings to be made. 

Port name 
Give the printer port a name. 

 

SCSI Interface 
The MultiPrinter and LF-CRT connect to the host computer via a SCSI interface. You can 
choose between: 

None (for testing no output) – Final printed output is not actually sent to 
the printer. Useful for testing. 

! 

! NT SCSI – Windows NT/2000 SCSI interface. Most commonly used 
interface 
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APSI – Adaptec’s SCSI interface. ! 

# 

Select the interface you wish to use. 

Automatic SCSI address selection 
The driver will search for any printers connected to the SCSI BUS. Normally, you should 
leave the SCSI selection to Automatically search SCSI bus(es) for printer. The driver will 
search for and use an on-line printer. 

If you have more than one printer attached to the same host computer, the driver 
will give an error. You must specify which printer to use by manually choosing the 
SCSI ID. 

 

Manual SCSI address selection 
To manually choose a SCSI ID, choose Specify SCSI address manually. The list of devices 
becomes available. Choose your printer from the list of devices. 

 
If you have more than one SCSI adapter installed in your computer, you can select the 
SCSI BUS to search by selecting it in the Bus number. Likewise, you can manually select 
the SCSI ID by selecting it in the Target ID drop-down. Make sure the Target ID matches 
the SCSI ID your printer is set to. 

Information about the printer found at the specified SCSI address is displayed at in the 
info panel. If a printer was not found at the specified, an error is shown. In this case, re-
check your printer is at the selected SCSI ID, that it is on-line and all the standard SCSI 
troubleshooting procedures are followed. 
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Advanced options 
You can specify a number of advanced options by choosing the Advanced… button. You 
would not normally make any changes here. 

 
Once you are happy with all the settings made, choose OK. The Ports dialog is shown. 
Make sure the port you just defined is selected, then click Next. 

 
Enter the name for your printer. This is the name as it will appear in the Printers folder. 
Choose Finish. 

 
The printer is added to the Printers folder, and is available for use. 
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Installing the hardlock driver 
If you are running the licensed version of the driver, you will need to connect the hardlock 
to a parallel port, and install the Windows NT device driver. 

The device driver is included on the distribution CD in the \Hardlock directory. Locate the 
file hldrv32.exe and double click it to start the driver installation. Follow the on-
screen prompts to install the device driver. 

Once the driver has been installed, shut down your computer, and connect the hardlock 
into a parallel port on your PC. Switch on the PC and allow it to boot. 

Testing the installation 
After the driver, printer, hardlock driver and hardlock have been installed to your PC, you 
can connect to the MultiPrinter printer. 

Printing a test page 
Make sure that the MultiPrinter is on-line. Choose Start > Settings > Printers. 

Open the printer spooler window 
The printer spooler window allows you to monitor the status of both the printer and jobs 
being printed by the MultiPrinter. Open the window by double-clicking the MultiPrinter 
printer icon in the Printers folder. Leave the spooler window visible during the following 
tests to monitor the printer status. 

 

Print the test page 
Choose Printer > Properties from the MultiPrinter spooler window. The printer properties 
panel opens. Choose the General tab and click the Print Test Page button. Windows NT 
prints a test page to the MultiPrinter. Unless an error is shown when printing the test page, 
choose Yes when Windows asks if the test page printed OK. 
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Note the activity in the spooler window and on the MultiPrinter. If all the previous 
connections and settings have been made correctly and the printer is on-line, the test page 
will be printed. 

Troubleshooting the installation 
There are various reasons why printing a test page might fail. If the test page does fail, pay 
particular attention to the following: 

The error message reported along with the test page failure notification ! 

! Open the Event Viewer and locate the MultiPrinter Spooler entry. Note the 
error reported there. 

User authentication errors 
Hardlock related 
The hardlock protects the driver against unauthorised use and must be connected to the 
PC’s parallel port in order for the printer driver to function. 

If the hardlock is missing, or there is a problem with the parallel port (hardware failure, 
missing driver etc.) the following error is given when a test page is printed: 
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The operation being requested was not performed because the user has not been 
authenticated. 

 
The Event Viewer will report the error as: 
The Hardlock dongle was not found. Printing will be disabled until the problem is fixed. 

 
Resolution: 

Connect the hardlock ! 

! 

! 

! 

! 

! 

! 

! 

If not done, install the hardlock driver. Normally the driver is installed 
with the printer driver (it is provided on the distribution CD) 
Check the parallel port hardware is functioning correctly 

Output related problems 
If the printer driver prints successfully, but has transparent colored lines over the output, it 
is possible that the Demo version of the driver is installed. To check the version installed: 

Open the Printers folder 
Right-click on the MultiPrinter printer 
Choose Properties. The MultiPrinter printer properties dialog opens. 
Choose the Help tab 
A Demo version of the driver will have Demo noted. 
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Configuring the MultiPrinter Windows NT printer driver is done in two places: 

Setting the Printer defaults ! 

! Setting the document defaults and properties 

Certain settings that are specific to the physical printer are set as a document default. 
These include things such as the currently installed paper, default paper sizes that are not 
normally changed by the operator when printing a job. 

Settings such as the chosen page size, number of prints and the like are set either as a 
document default, or on a per document basis. 

Setting the printer default settings 
Before any prints can be made using the printer driver, the printer default settings must be 
set. Open the Printers folder by choosing Start > Settings > Printers. The Printers folder 
opens. Locate and right click the MultiPrinter printer icon. Choose Properties from the 
contextual menu list –  the Printer Properties dialog is displayed. 
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Setting the General properties (Windows 2000) 
When the Properties dialog first opens, you will see the General Properties tab. 

 

Comment 
If you want to add any comments regarding the printer, add them, here. 

Location 
If the printer is connected as a network device, enter the location of the printer here. There 
may be a location automatically added here if you are adding a network printer. 

Print Test Page 
Prints the Windows NT printer test page. 

Printing Preferences… (Windows 2000) 
You can inspect the default Print preference settings by choosing either Printing 
Preferences… in the Print dialog, or by clicking the printer icon in the Printers folder, then 
choosing File > Printing Preferences… 

Details about the various options can be found in Chapter 4, Document configuration. 

 

Sharing the printer 
Windows NT allows sharing of printers across a network. This means that a user can 
access a printer quickly and efficiently. It is also great for administrators to help manage 

 

MultiPrinter printer driver – Driver configuration Page 11 



the printer device, as they can make printer default settings, forcing users to choose from 
the available settings. 

To share the printer, choose the Sharing tab. 

  
To share the printer, Choose Shared as, then enter the shared printer name. 

Choose the Ports 
Most of the important settings for the MultiPrinter driver are included in the Ports tab. 
Click the Ports tab, and this dialog is displayed. 

 
You should not normally change the port in use by the printer. 
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Configuring the port 
The printer port controls the various interface settings used by the driver. You can change 
the port settings by choosing Configure Port… 

 
There are several settings to be made. 

Name 
Give the printer port a name. 

SCSI Interface 
The MultiPrinter and LF-CRT connect to the host computer via a SCSI interface. You can 
choose between: 

None (for testing no output) – Final printed output is not actually sent to 
the printer. Useful for testing. 

! 

! 

! 

NT SCSI – Windows NT/2000 SCSI interface. Most commonly used 
interface 
APSI – Adaptec’s SCSI interface. 

Select the interface you wish to use. 

 

Automatic SCSI address selection 
The driver will search for any printers connected to the SCSI BUS. Normally, you should 
leave the SCSI selection to Automatically search SCSI bus(es) for printer. The driver will 
search for and use an on-line printer. 

# If you have more than one printer attached to the same host computer, the driver 
will give an error. You must specify which printer to use by manually choosing the 
SCSI ID. 
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Manual SCSI address selection 
To manually choose a SCSI ID, choose Specify 
SCSI address manually. The list of devices 
becomes available. Choose your printer from 
the list of devices. 

If you have more than one SCSI adapter 
installed in your computer, you can select the 
SCSI BUS to search by selecting it in the Bus 
number. Likewise, you can manually select the 
SCSI ID by selecting it in the Target ID drop-
down. Make sure the Target ID matches the SCSI ID your printer is set to. 

Information about the printer found at the 
specified SCSI address is displayed at in the 
info panel. If a printer was not found at the 
specified, an error is shown. In this case, re-
check your printer is at the selected SCSI ID, 
that it is on-line and all the standard SCSI 
troubleshooting procedures are followed. 

 

Advanced options 
You can specify a number of advanced options by 
choosing the Advanced… button. You would not 
normally make any changes here. 

Device Settings 
There are a number of printer specific settings that need 
to be made. These settings are the kind of thing that don’t usually change from document 
to document. Settings made here change those available as a document setting. 

These settings are made from the Device Settings tab. 

Set the paper width 
Click the Installed Paper Roll Width. A list of 
the available widths is displayed at the bottom 
of the dialog. Choose the paper width 
currently installed in the MultiPrinter. 

If you don’t see the paper width in the list that 
you want to use, click Other… Enter the 
desired width. 
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Set the Scale 
The MultiPrinter operates in several different scales. Set the scale by clicking Scale, then 
choosing the range from those available. 

# You must enter the Scale values determined by the 
installing technician. 

  

Set the available forms 
You may use a number of standard paper sizes to print your jobs on the MultiPrinter. The 
paper sizes defined here are those that the operator can select as the paper size when 
printing. Ensure Forms… is selected in the dialog, and choose Forms Setup… The Forms 
Setup dialog is displayed. 

Create a new form 

Click the New Form button. A new entry appears in the list. Enter the 
name for the new form. 

! 

! 

! 

Choose the measurement units (English or Metric) 
Enter the paper dimensions. 

If you want to add another new form, click the New button again and repeat the operation. 

  
Remove a form 

Click the name of the form you wish to remove, and click the Delete button. 
The form is removed from the list. 

 

MultiPrinter printer driver – Driver configuration Page 15 



Set which forms are available for selection. 
It is possible to set which forms are available to the operator when printing. Choose 
Listing from the list. The available settings are shown at the bottom of the dialog. 

Always list all forms ! 

! 

! 

Exclude forms wider than paper roll 
Only list forms with the same width as paper roll 

 

Using image compression when printing 
When pages are printed directly from an application to a MultiPrinter somewhere else on 
your local network, you can choose to compress the printed image data. This helps 
optimise your network traffic, and keep it useable. 

For example, a page when printed to a TGA file is 60Mb. The same file may be 15Mb 
when JPEG compressed. 

You can choose either PNG or JPEG compression. PNG is designed to be a ‘lossless’ 
compressed image format, while JPEG is better known, but is ‘lossy’. A higher 
compression factor with JPEG will result in poorer image quality, but smaller files. PNG 
is slightly slower, and creates larger (but potentially better quality) compressed files than 
JPEG. 

  

Setting the Printer Security 
The Windows NT printer driver model allows for printer security when users use the print 
driver. This is very useful in a large lab environment to ensure that only authorised 
personnel can print files to the MultiPrinter. Choose the Security tab and apply the security 
settings desired. Consult Windows NT help for more information regarding printer 
security. 
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Printer Information 
Important information such as version numbers are displayed in the Help tab. 

 

Printer calibration 
Each image that is printed can be corrected for brightness, color balance or contrast, as it 
is printed. 

# You should ensure that the printer is calibrated correctly using the calibration 
software. The color corrections here should be used only if necessary. 
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You can apply a color correction to all pages printed on the MultiPrinter by creating a 
color correction. Corrections are applied by defining a LUT with the LUT editor. Basic 
and advanced LUTS are available. See the later chapter on the use of the LUT editor. 

  

LUT mode switches 

LUT preview graph 

LUT construction tools 

There are two main areas of interest: 

LUT construction tools ! 

! 

! 

! 

LUT mode switches 

LUT modes 
There are several types of LUT that can be constructed. The most important are: 

Basic 
Advanced 

There are other modes available by using the mode switch buttons, . These should 
only be used by experienced persons. 

Switch a LUT mode by choosing the Basic / Advanced switch and 
choosing the desired mode. 

Create a basic LUT 
Basic LUTs allow: 

An overall gamma ! 

! 

! 

A specific Red, Green or Blue gamma 
A custom black and white point 

Choose a gamma 
Enter the required gamma value either by sliding the gamma slider, or entering a value. 
The graph will preview the new LUT. 

Choose a specific color’s gamma by choosing the color from the toolbar, and applying the 
required gamma. 
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Choosing a black and white point 
Black and white points can chosen by sliding the slider, or entering a value. As the value 
is changed, the graph previews the change. 

You might want to change the black or white points if the images being printed have bad 
black points. You can see this by inspecting the images in a bitmap editing program such 
as Adobe Photoshop. If the darkest pixel is greater than 0, and the whitest lower than 255, 
you might want to adjust these values. 

  
A LUT is constructed by choosing the required gamma value, either with the slider, or by 
entering a value. 

Create an advanced LUT 
Advanced LUTs allow: 

Overall gamma correction ! 

! 

! 

! 

! 

Black point setting 
White point setting 
Shadow correction 
Highlight correction 

If you want to specifically brighten the shadow areas, or darken the highlights, or even 
bias the color of the shadow or highlight areas, the advanced LUT tools will be very 
useful. 

The adjustments available for gamma, black and white point correction are similar to the 
basic LUT. The added tools are Gamma High and Gamma low corrections. As you adjust 
these sliders, the shadow or highlight areas only are changed. 
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If you want to bias a particular color, choose the color from the LUT mode toolbar, and 
make the corrections. 

Using the test image 
The image supplied provides a standard image that allows you to compare printers and 
monitors. If after calibrating your printer, the test image still prints with a color cast, apply 
a correction as specified below: 

Test image is… Then… 

Too dark Increase the printer LUT gamma, e.g. change the gamma from 1.0 to 1.3 

Too light Decrease the printer LUT gamma 

Too red Decrease the printer LUT red gamma 

Too cyan Increase the printer LUT red gamma 

Too green Decrease the printer LUT green gamma 

Too magenta Increase the printer LUT green gamma 

Too blue Decrease the printer LUT blue gamma 

Too yellow Increase the printer LUT yellow gamma 

 
If you are calibrating multiple printers, pick one of the printers as the master, and balance 
this one first. After the system is calibrated with one printer, construct a LUT that corrects 
any differences between the printers. 

The test image is called Calibration.tif and is in the Program Files\Timestone Software\ 
directory of the hard drive. 
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Once the driver has been installed, and the printer defaults set, it is available for use 
within Windows NT. When you print using the driver, you can specify various settings for 
the particular job you are printing. Certain settings (such as resolution range, paper width) 
are printer defaults and cannot be changed, but there are several settings you can change. 

General document options 
Choose Printer Properties from the print dialog. The current Page Setup is shown. Choose 
the desired paper from the Paper Size drop-down, the number of prints required and paper 
orientation. 

Most of these settings mirror those entered in the application’s normal Print… dialog. 

Printing Preferences… (Windows 2000) 
Printing preferences are set by choosing either Printing Preferences… in the Print dialog, or 
by clicking the printer icon in the Printers folder, then choosing File > Printing 
Preferences… 

 

Set the Orientation 
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Choose which orientation to print the pages. 



Set the Advanced Options 
To set the advanced options, click Advanced… The Advanced Printing Preferences is 
displayed. 

Paper Size and print count 
Choose the paper size from the drop down and enter the print quantity. 

  

Sharpening 
Images printed can be sharpened by enabling sharpening. Choose the sharpness strength 
by entering it to the Strength entry box. Click the Advanced… button to access advanced 
options. Note that you should not normally change the Kernel size. Sharpness is applied 
using an unsharp mask algorithm, and the kernel size will increase the effect, but possibly 
introduce image artefacts. 

# Sharpening an image while printing can take some time. You should attempt to 
apply any sharpening required at the scanner to ensure maximum productivity from 
your printer. 

       

Over-Bleed 
It is possible for the paper to mis-track slightly as it is transported through the printer. To 
allow for this fine tracking, you can enable over-bleeding. This enlarges the image by 
0.05" on both sides of the paper. 
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Banding 
If your PC struggles with rendering due to insufficient memory, you can segment the 
rendering tasks into bands. This can help ensure the images are correctly rendered, even in 
low memory situations. However, we strongly recommend that you install more memory 
if you are in this situation, as banding will slow print times. 
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Once the driver has been installed, and the printer defaults set, it is available for use 
within Windows NT. When the user prints from the driver, they can specify various 
settings for the particular job they are printing. There are a number of things that cannot 
be changed (such as resolution range, paper width), as they are a printer default. 

Using the print driver is gathered into three main areas: 

Printing from an application ! 

! 

! 

Using the Windows NT print spooler 
Printing across a network 

Calibrating and configuring the printer 
Your MultiPrinter and LF-CRT come with a calibration application that you should use to 
calibrate and select the paper type in use. The printer driver has no similar functionality 
integrated, so you must use the Kodak software for these functions. 

Paper calibration 
When using a new paper type, or starting the machine up in the morning, you should run a 
calibration strip to ensures the best possible quality. Follow the Kodak calibration manual 
for information. 

Selecting the paper type 
When you load a new paper type into the printer, the printer must have the calibration data 
for that paper loaded. This must be done with the Kodak calibration software. Follow the 
Kodak calibration manual for information. 

Printing from an application 
Using the printer driver will be a familiar operation to the user. The user can choose to set 
the printer document settings from the Properties dialog within the application they are 
using. 

Please consult the Windows NT documentation and application user manual for 
information on printing. 

 

Printer printer driver – Using the driver Page 24 



Supported applications 
You can print from any standard Windows NT application with the MultiPrinter driver. 
Each application you use will offer different ways and features when printing to a printer. 

The MultiPrinter driver is not a PostScript compatible driver. If you try to print from an 
application that contains embedded PostScript the PostScript content will be the low-
resolution preview only. 

Setting the document options 
As mentioned, you can set various document defaults for a printer. When the operator first 
uses the printer, these options will be the ones that will appear. The user can make their 
own settings as desired. For a detailed description of the settings, please consult the 
previous chapter. 

Using the Windows NT print spooler 
Windows NT printing uses the Print Spooler to allow you to control the jobs submitted to 
the printer. When a document is submitted to the spooler, a printer icon will appear in the 
System tray at the right of the Task Bar. 

 

Printer icon in the System Tray 

Double-clicking the icon opens the Spooler window. You can also open the spooler 
window by opening the Printers folder, then double-clicking the printer’s icon. 

When a job is submitted to the Windows spooler, it can be controlled by the operators on 
the network or on the print server. The spooler allows functions such as pausing the 
printer, cancelling jobs, promoting a job’s priority and so on. 

Please consult the Windows NT help system or your System Administrator for 
information regarding using the spooler. 

Printer condition reporting 
There are various messages regarding the printer’s status that can be reported by the 
spooler window. These messages are displayed in the spooler’s title bar. 

Please consult the following chapter for information regarding these messages. 
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Printing across a network 
Windows NT printer drivers allow printer sharing across a computer network. You should 
consult your Windows NT help system, user documentation or System Administrator for 
detailed information regarding printer sharing. 

Network Traffic 
Because the files you print to the MultiPrinter are high-resolution, printing across a 
computer network involves sending large amounts of data. If you have several operators 
printing to the MultiPrinter across a network, you may find that the network will slow. If 
you experience this issue, you should enable image compression as described in a 
previous chapter. 

Special Features with Timestone Software’s PrintTime 
Timestone Software has created an imaging tool that simplifies the task of printing images 
to the printer. It also offers special support when printing image files that are pre-sized 
ready to print. These files might come from a third-party application that creates bitmap 
files for its jobs. 

Normally, when PrintTime prints a job, it process the image data through the normal 
Windows NT print layers. This process takes some time. When the image files you are 
printing have been correctly sized, this extra processing time is un-necessary. PrintTime 
works with the printer driver to by-pass these layers, and send the image data directly to 
the printer. 

Please consult accompanying the PrintTime documentation for information on this 
function. 
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